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Bridging the Divide: From Talent Management 
to Human Potential

4

The advance of AI means every company is 

transforming to survive and thrive. Yet - 

perhaps contrary to popular belief - digital 

transformation is less about technology 

and more about people. The ability to 

adapt to an even more digital future 

depends on developing the next generation 

of skills, closing the gap between talent 

supply and demand, and future-proofing 

your own and others’ potential.

Understanding what people want from work 

and helping them to develop their skills 

throughout long working lives has never 

been more critical. That's why I am so 

pleased to share our latest Global Talent 

Barometer, offering workers the opportunity 

to share how they are feeling about the

world of work today and tomorrow. It also 

gives employers much needed insight to 

understand employee needs and identify 

best practices that stand out in this 

competitive global talent market.

Our data continues to confirm that 

people expect work to offer them more. 

More balance. More flexibility. More 

humanity. And importantly – more 

development.

Yet one in three workers say they don't 

have enough opportunities to achieve their 

career goals at their current employer. 

Regular skill-building opportunities don't just 

create capability – they signal organizational 

commitment to people's futures.

As talent shortages continue to grow 

and technology accelerates, the 

ability to unleash potential and build 

talent mobility is key to business 

growth. The Global Talent 

Barometer shows that leading 

organizations are designing 

workflows that build resilience 

rather than deplete it and involving 

employees as partners rather than 

shielding them from business 

realities. It is now up to us to listen, 

to partner, and to act, and this data 

helps us do just that.

Thank you for joining us as we shape 

the future of work by putting people at 

the center of everything we do.

Becky Frankiewicz​

President & Chief Strategy Officer, 

ManpowerGroup
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Global Talent 
Barometer 
Methodology

The ManpowerGroup Global 

Talent Barometer measures 

worker well-being, job 

satisfaction, and confidence 

around the world. This 

comprehensive tool leverages 

independent survey best-

practices and statistically 

significant samples to create a 

powerful tool to better understand 

what workers want globally. The 

research aims to improve the 

future of work through deeper 

understanding the key drivers of 

workforce sentiment today.​

Fieldwork Conducted: 

March 14 – April 11, 2025

19 Countries Surveyed:

Australia, Canada, France, Germany, India, Israel, 

Italy, Japan, Malaysia, Mexico, The Netherlands, 

Norway, Poland, Singapore, Spain, Sweden, 

Switzerland, United Kingdom (U.K.), and the United 

States (U.S.).

Survey Methodology:

Survey responses were collected from 13,771 

workers. All the data is weighted to match the worker 

population in each country by gender, age and region, 

and all countries are weighted to be equal.

Modified Question Wording ​:

Edits have been made to question text throughout this 

report to ensure readability. Complete versions of any 

shortened statements can be found in the 'About the 

Survey' section at the end of the report.
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Now in its second installment, the Global 

Talent Barometer – reflecting worker 

sentiments across three indices 

comprised of twelve distinct benchmarks 

– stands at 68%. Despite a decline in job 

satisfaction, the data reveals a notable rise in 

workers’ confidence and overall well-being.

The research reveals what employees need 

and value most, helping employers 

understand and act on key drivers to attract 

and retain top talent in a changing world 

of world.
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Key Findings
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Worker Sentiment Around the World
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47%

63%

64%

66%

66%

68%

68%

68%

69%

69%

69%

69%

70%

71%

71%

73%

73%

73%

79%India

Mexico

The Netherlands

U.S.

Canada

U.K.

Malaysia

Australia

France

Norway

Poland

Germany

Spain

Sweden

Italy

Switzerland

Singapore

Israel

Japan

Workers in Israel have lower confidence 

in their skills and experience to perform 

their job and are among the least likely to 

change jobs in the next six months.

Workers in India reported below-average 

job security and satisfaction, despite being 

highly confident in their skills and ability to 

use the latest tech in their industry.

Workers in Mexico and India 

reported the highest levels of meaning 

and purpose and values alignment.
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The Stress-Retention Connection

Workplace stress remains high worldwide.

Stress levels are similar between all roles, but 

middle managers reported the most stress.

Despite more workers finding 

their work meaningful and 

purposeful, nearly half of the 

workforce continue to experience 

moderate to high daily stress. Nearly half (46%) are concerned about their 

workload impacting work-life balance.

Stress is exacerbated among 

Gen Z: They continue to 

experience the highest daily 

stress levels, despite feeling 

increased support.

Gaps in values alignment between essential workers and 

executive and senior-level management are considerable.

82%Middle

Managers

Experience

High Stress

56%

89%

65%Essential Workers

Executive and Senior-Level Management
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Stuck in the Middle

Job Satisfaction Decreases for Middle Managers and Women

Millennial job satisfaction drops 11% since 2024 - the 

sharpest drop of any generation.

Most managers (77%) see 

restructuring and AI as their 

greatest career threats.

34% of managers are bracing 

for possible job loss in the 

coming 6 months.

43%

63%Onsite Without Choice

Fully or Mostly Remote

Rank lowest on the 

Job Satisfaction Index

Millennial 

Women

Even under pressure and 

uncertainty, managers continue 

to build trust. More workers now 

believe their managers have 

their backs (+4pp) since 2024.

67%

10

Location signals job satisfaction as workers who are onsite 

without choice are less likely to leave in six months compared 

to their fully or mostly remote counterparts.
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Development as Trust Currency

Employers benefit from improved career pathing and development.

Hybrid workers lead in career 

confidence, topping all four benchmarks. Workers in IT report 

the strongest 

career growth and 

skills confidence.

Gender inequality 

persists in 2025, with 

women reporting 

fewer career moves 

and promotions.

Backed by career support and 

undeterred by tech advancements, 

workers are feeling sharper as skills 

confidence grows (+2pp).

Worker confidence rose +2pp since 2024, driven by reported 

increased career development and career opportunities.

62%
(+5pp)

77%
(+4pp)
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53%

60%

57%

66%

Women

Men
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The Well-Being Index an average of the above percentages. Learn more about the Methodology. 

Better Work-Life Balance Boosts Well-Being

Well-Being Index

67%
69%

74%

42%

82%

Feel work has at least some meaning or purpose.

Feel somewhat or closely aligned with company vision and values.

Feel well or fully supported with regards to work-life balance.

Feel little to no stress.

The Well-Being Index is based on four distinct benchmarks: 

meaning and purpose, minimal daily stress, values alignment, and work-life balance. 
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Well-Being Index Values AlignmentMeaning and Purpose Minimal Daily Stress Work-Life Balance

Country-Level Perspectives
Examine how well-being varies from nation to nation and its driving factors.​
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69%

74%

42%

82%

67%

Global Average

72%

76%

41%

80%

67%

Australia

75%

78%

42%

86%

70%

Canada

68%

71%

43%

80%

65%

France

64%

70%

47%

85%

67%

Germany

89%

93%

40%

93%

79%

India

62%

72%

41%

78%

63%

Italy

45%

43%

28%

57%

43%

Japan

71%

74%

48%

83%

69%

Malaysia

73%

88%

38%

92%

73%

Mexico

74%

76%

55%

85%

72%

The Netherlands

66%

77%

53%

84%

70%

Norway

70%

72%

33%

75%

63%

Singapore

65%

74%

33%

84%

64%

Spain

68%

74%

38%

83%

66%

Sweden

63%

65%

43%

84%

64%

Switzerland

73%

78%

41%

84%

69%

U.K.

62%

72%

50%

76%

65%

Israel

72%

78%

40%

85%

68%

Poland

77%

80%

42%

84%

71%

U.S.

Workers in India 

reported the highest 

overall well-being, driven 

by meaningful work and 

values alignment.

Japanese workers 

are the most likely to 

report high daily 

stress, followed by 

Singapore and Spain.
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Industry Insights
Explore how well-being differs across key industry verticals.

15

Well-Being Index Values AlignmentMeaning and Purpose Minimal Daily Stress Work-Life Balance

Industrials and 

Materials and IT workers 

reported the greatest 

overall well-being.

IT workers were the most 

likely to report moderate 

to high daily levels of 

workplace stress.

67%

70%

70%

68%

69%

69%

63%

65%

67%Global Average

Communication Services

Consumer Goods 

and Services

Energy and Utilities

Financials and Real Estate

Health Care and

Life Sciences

Industrials and Materials

Information Technology

Transport, Logistics,

and Automotive
73%

81%

78%

74%

77%

79%

71%

73%

74%

82%

84%

85%

86%

83%

85%

76%

79%

82%

42%

37%

44%

42%

42%

39%

41%

38%

42%

71%

77%

74%

68%

74%

71%

65%

70%

69%
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Role and Location Trends
Uncover the connection between job roles, work locations and overall well-being.  

74%

71%

69%

62%

61%

67%

89%

87%

84%

76%

79%

82%

38%

40%

41%

42%

43%

42%

87%

81%

78%

67%

65%

74%

82%

75%

73%

63%

57%

69%

Essential Front-

Line Worker

Blue-

Collar

White-

Collar

Middle 

Manager

Executive

or Senior

Global 

Average

Role

68%

72%

70%

63%

63%

67%

83%

86%

84%

79%

79%

82%

36%

41%

41%

40%

46%

42%

77%

82%

80%

70%

67%

74%

76%

79%

73%

63%

59%

69%

Onsite without

Choice

Onsite by

Choice

Mostly

Onsite

Hybrid

Fully or Mostly

Remote

Global 

Average

Work Location

Well-Being Index Values AlignmentMeaning and Purpose Minimal Daily Stress Work-Life Balance

Essential front-line 

and blue-collar 

workers reported the 

lowest overall Well-

Being across roles 

and locations.

Gap in values 

alignment between 

essential workers 

and executive and 

senior management 

is considerable.
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Age-Gender Dynamics
Examine well-being differences and similarities by age group and gender.

69%

68%

68%

74%

69%

65%

63%

63%

69%

64%

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

83%

82%

83%

88%

83%

81%

80%

80%

87%

81%

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

37%

39%

48%

59%

45%

34%

34%

42%

54%

38%

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

79%

78%

74%

77%

77%

75%

73%

69%

71%

72%

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

76%

74%

68%

72%

72%

69%

66%

62%

67%

66%

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Baby 

Boomers
(ages: 60-78)

Gen X
(ages: 44-59)

Millennials
(ages: 28-43)

Gen Z
(ages: 18-27)

Global 

Average

Well-Being Index Values AlignmentMeaning and Purpose Minimal Daily Stress Work-Life Balance

Gen Z succeeds in 

demanding work-life 

support, but stress 

levels remain 

stubbornly high.

The gender gap in 

work-life balance is 

the greatest 

between millennial 

men and women.
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Job Satisfaction
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Less Job Satisfaction and Security, More Trust in Managers

The Job Satisfaction Index an average of the above percentages. . Learn more about the Methodology. 

The Job Satisfaction Index is based on four distinct benchmarks: 

current job satisfaction, job security, job-search confidence, and manager trust. 

Job Satisfaction Index

62%
67%

61%

65%

55%

Satisfied with their job and unlikely to voluntarily leave in the next six months.

Have moderate to high confidence of ability to find another job in the next six months.

Have moderate to high trust their manager has their best interests in mind for career development.

Feel their job is secure for the next six months.

19
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Country-Level Perspectives
Explore how job satisfaction differs across countries.

2020

Job Satisfaction Index Job-Search ConfidenceCurrent Job Satisfaction Current Job Security Trustworthy Manager

67%

61%

65%

55%

62%

Global Average

70%

69%

65%

52%

64%

Australia

70%

64%

66%

52%

63%

Canada

68%

62%

64%

60%

64%

France

65%

62%

64%

58%

62%

Germany

89%

81%

54%

38%

65%

India

59%

53%

66%

57%

59%

Italy

46%

28%

70%

66%

52%

Japan

75%

57%

61%

49%

61%

Malaysia

74%

66%

63%

55%

64%

Mexico

72%

65%

69%

61%

67%

The Netherlands

63%

57%

78%

63%

65%

Norway

66%

63%

50%

42%

55%

Singapore

66%

57%

64%

58%

61%

Spain

62%

58%

69%

55%

61%

Sweden

66%

58%

60%

54%

59%

Switzerland

70%

67%

69%

55%

65%

U.K.

53%

46%

64%

64%

57%

Israel

61%

60%

65%

57%

61%

Poland

75%

71%

67%

55%

67%

U.S.

While India tops the 

charts for most 

aspects of work, they 

rank the lowest for 

job security and 

satisfaction, along 

with Singapore.

Japanese workers 

think they are unlikely 

to be forced out of 

their job in the next six 

months, while ranking 

below average on all 

other factors.
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Industry Insights
Examine sector-specific trends in worker job satisfaction.
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Job Satisfaction Index Job-Search ConfidenceCurrent Job Satisfaction Current Job Security Trustworthy Manager

61%

62%

64%

64%

63%

59%

60%

59%

62%Global Average

Communication Services

Consumer Goods 

and Services

Energy and Utilities

Financials and Real Estate

Health Care and

Life Sciences

Industrials and Materials

Information Technology

Transport, Logistics,

and Automotive
60%

70%

65%

62%

64%

70%

58%

58%

61%

55%

47%

55%

57%

52%

45%

53%

52%

55%

62%

57%

64%

70%

61%

52%

66%

61%

65%

68%

75%

71%

67%

74%

70%

63%

67%

67%

IT and Energy 

and Utilities 

workers feel the 

least secure in their 

jobs while reporting 

the highest job-

search confidence.

Managers are 

reportedly the least 

trustworthy in 

Consumer Goods 

and Services.
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Role and Location Trends
Examine how job roles and working locations shape employee satisfaction.

22

Essential frontline 

workers feel the 

most secure in their 

jobs, while executive 

or senior-level roles 

are the least secure.

Middle Manager 

workers are most 

likely to be satisfied 

with their jobs.

Job Satisfaction Index Job-Search ConfidenceCurrent Job Satisfaction Current Job Security Trustworthy Manager

63%

64%

63%

58%

59%

62%

46%

51%

55%

54%

57%

55%

51%

61%

64%

63%

70%

65%

73%

68%

63%

56%

54%

61%

82%

75%

71%

58%

57%

67%

Essential Front-

Line Worker

Blue-

Collar

White-

Collar

Middle 

Manager

Executive

or Senior

Global 

Average

Role

58%

64%

63%

61%

62%

62%

43%

52%

54%

58%

63%

55%

51%

61%

64%

66%

73%

65%

66%

67%

63%

57%

53%

61%

72%

77%

72%

62%

58%

67%

Onsite without

Choice

Onsite by

Choice

Mostly

Onsite

Hybrid

Fully or Mostly

Remote

Global 

Average

Work Location
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Job Satisfaction Index Job-Search ConfidenceCurrent Job Satisfaction Current Job Security Trustworthy Manager

Age-Gender Dynamics
Explore how different age groups and genders experience job satisfaction.

23

Gen Z workers are 

the most likely to 

say they want to 

voluntarily leave 

their current 

employer, while also 

feeling the least 

secure in their jobs.

Millennials report 

the steepest drop in 

job satisfaction, 

decreasing six 

percentage points 

since 2024.

61%

60%

65%

68%

63%

59%

59%

61%

66%

60%

43%

46%

64%

76%

56%

41%

48%

64%

80%

54%

56%

56%

71%

77%

64%

56%

62%

71%

78%

65%

68%

69%

59%

52%

63%

67%

61%

49%

45%

57%

74%

72%

65%

69%

69%

70%

66%

59%

62%

64%

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Women

Men

Baby 

Boomers
(ages: 60-78)

Gen X
(ages: 44-59)

Millennials
(ages: 28-43)

Gen Z
(ages: 18-27)

Global 

Average
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Confidence
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The Confidence Index is the an average of the above percentages. Learn more about the Methodology. 

Rising Confidence and Career Growth
The Confidence Index is based on four distinct benchmarks: 

career development, career opportunities, experience and skills, and tech and tools.

Confidence Index

76%
78%

89%

62%

77%

Have opportunities to gain skills and experiences to achieve their career goals at the organization.

Have moderate to high confidence in their skills and experience to perform their job.

Have mostly or completely the latest tech available to their industry.

Have opportunities for promotion or movement within the organization.
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Country-Level Perspectives

Confidence Index Experience and SkillsCareer Development Career Opportunities Latest Tech

Examine how worker confidence is experienced around the globe.

2626

78%

89%

62%

77%

76%

Global Average

78%

91%

64%

77%

77%

Australia

84%

91%

65%

81%

80%

Canada

79%

88%

61%

79%

77%

France

72%

90%

64%

78%

76%

Germany

94%

97%

89%

91%

93%

India

80%

90%

56%

73%

75%

Italy

43%

60%

34%

47%

46%

Japan

85%

90%

68%

80%

81%

Malaysia

89%

92%

65%

84%

83%

Mexico

77%

90%

66%

82%

79%

The Netherlands

69%

87%

56%

72%

71%

Norway

78%

82%

64%

72%

74%

Singapore

86%

91%

56%

78%

78%

Spain

81%

92%

56%

74%

76%

Sweden

75%

88%

59%

77%

75%

Switzerland

81%

92%

64%

79%

79%

U.K.

69%

83%

49%

66%

67%

Israel

81%

92%

65%

77%

79%

Poland

83%

94%

69%

83%

82%

U.S.

India reported the 

best overall workforce 

confidence, with strong 

worker sentiment the 

strongest across all 

four benchmarks.

Germany and 

Norway reported 

below-average 

confidence in using 

their industry’s latest 

tech and tools.
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Industry Insights

78%

84%

80%

76%

81%

81%

72%

78%

76%Global Average

Communication Services

Consumer Goods 

and Services

Energy and Utilities

Financials and Real Estate

Health Care and

Life Sciences

Industrials and Materials

Information Technology

Transport, Logistics,

and Automotive
89%

91%

89%

91%

90%

91%

87%

87%

89%

78%

83%

81%

77%

82%

80%

71%

78%

77%

65%

73%

67%

59%

70%

70%

56%

64%

62%

78%

88%

81%

77%

83%

82%

76%

81%

78%

Understand how sector-specific factors influence worker confidence.

27

Confidence Index Experience and SkillsCareer Development Career Opportunities Latest Tech

Consumer Goods 

and Services report 

the lowest 

confidence, especially 

when it comes to 

career development 

and opportunities.

Financials and Real Estate 

workers reported the best 

career development 

opportunities, along with 

one of the highest levels 

of skills confidence.
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Role and Location Trends
Analyze how different roles and work settings influence employee confidence.
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Confidence Index Experience and SkillsCareer Development Career Opportunities Latest Tech
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Essential front-line 

workers and those who 

are onsite without choice 

reported the lowest 

career opportunities.

Hybrid workers 

expressed the highest 

confidence in all 

areas: experience and 

skills, tech and tools, 

career development, 

and opportunities.
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Age-Gender Dynamics
Explore how worker confidence varies across different age groups and genders.
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Gender inequalities 

persist, but Gen Z 

workers report the 

smallest gender 

differences across 

all confidence 

benchmarks.

Gen X and Baby 

Boomers report the 

greatest gender 

discrepancy in 

career opportunities.
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While more workers find purpose in 

their jobs, persistent daily stress — 

especially among Gen Z and middle 

managers — remains high. This will 

increase costs as it begins to impact 

productivity and retention. 

Conservative global estimates for the 

cost of poor retention are $18,591 per 

employee that leaves the organization. 

These costs will quickly add up for 

underperforming organizations as they 

lose their top performers.

As job security concerns grow and 

current job satisfaction declines, mid-

career professionals, especially 

women, represent a critical yet 

underutilized talent pool. Employers 

looking to stabilize their workforce 

should prioritize this group with clear 

career paths, recognition, and support. 

Recent research estimates 

organizations that prioritize manager 

development and engagement are 

already realizing productivity 

improvements of up to 28%.

Despite growing uncertainty, workers 

are now more confident overall 

compared to 2024. As organizations 

look to retain essential talent, it’s 

imperative to focus on key factors 

within their control that are driving 

these positive sentiments. 

Continue strengthening and fostering 

trust between managers and 

employees, promoting work-life 

balance, and providing transparency 

regarding opportunities for 

professional development and 

advancement within the company.

Meeting workers in the middle.Meaningful work can’t outrun burnout ​. Capitalize on confidence ​.

Opportunities for Employers
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ConfidenceWell-Being Job Satisfaction

https://www.gartner.com/en/human-resources/insights/employee-retention-strategy
https://www.gartner.com/en/human-resources/insights/employee-retention-strategy
https://www.gallup.com/workplace/349484/state-of-the-global-workplace.aspx
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This report contains forward-looking statements, 

including statements regarding labor demand in 

certain regions, countries and industries, economic 

uncertainty, and the use and impact of AI. Actual 

events or results may differ materially from those 

contained in the forward-looking statements, due to 

risk, uncertainties and assumptions. These factors 

include those found in the Company’s reports filed 

with the U.S. Securities and Exchange Commission 

(SEC), including the information under the  heading 

“Risk Factors” in its Annual Report on Form10-K for 

the year ended December 31, 2024, whose 

information is incorporated herein by reference. 

ManpowerGroup disclaims any obligation to update 

any forward-looking or other statements in this 

release, except as required by law.

About the Survey

Survey responses were collected from 13,771 workers 

across 19 countries from March 14 to April 11, 2025. 

All the data is weighted to match the worker 

population in each country by gender, age and region, 

and all countries are weighted to be equal.

Survey Methodology:

Forward-Looking Statements:
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• Minimal Daily Stress: 

Percentage of workers who rate 

their stress levels as ‘little’ to ‘no 

stress’ using a 10-point scale.

• Meaning and Purpose: 

Percentage of workers who rate 

their work is being either 

‘somewhat’ or ‘very meaningful” 

using a 10-point scale.

• Values Alignment: 

Percentage of workers who rate 

their alignment with their 

employer’s values as “somewhat” 

or “closely aligned” using a 10-

point scale.

• Work-life Balance: 

Percentage of workers who rate 

their company’s support for work-

life balance and personal well-

being as “well” or “completely 

supported” using a 10-point scale.

• Well-Being Index: 

The Well-Being Index an average 

of the above percentages.

• Current Job Satisfaction: 

Percentage of workers who agree 

they are “very unlikely” or “unlikely” 

to change jobs on their own 

initiative, using a 10-point scale.

• Current Job Security: 

Percentage of workers who agree 

they are “very unlikely” or “unlikely” 

to be forced to leave their current 

job, using a 10-point scale.

• Job-Search Confidence: 

Percentage of workers who agree 

they’re “very confident” or 

“confident” they could find another 

job that meets their needs, using a 

10-point scale.

• Trustworthy Manager: 

Percentage of workers who 

agree they “trust very much” or 

“somewhat trust” that their 

manager has their best interests 

at heart concerning their career 

development, based on a 

10-point scale.

• Job Satisfaction Index: 

The Job Satisfaction Index an 

average of the above percentages.

• Experience and Skills: 

Percentage of workers who agree 

they are “very confident” or 

“confident” they have the skills and 

experience to perform their current 

job, using a 10-point scale.

• Career Development: 

Percentage of workers who agree 

they “very much so” or “do” have 

enough opportunities to gain the 

skills and experience they need to 

achieve their career goals at their 

current organization, using a 

10-point scale.

• Career Opportunities: 

Percentage of workers who agree 

they “very much so” or “do” have 

enough opportunities for promotion 

or movement within their 

organization to achieve their career 

goals, using a 10-point scale.

• Latest Tech: 

Percentage of workers who agree 

they “very much so” or “do” feel 

they have the right technology and 

tools available to do their job to the 

best of their ability, based on a 

10-point scale.

• Confidence Index: 

The Confidence Index is the an 

average of the above percentages.

Well-Being Job Satisfaction Confidence
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ManpowerGroup Solutions Across the Entire HR Lifecycle

Workforce 

Management

Talent

Resourcing

Career

Management

Top Talent

Attraction

Strategic Workforce 

Planning

Workforce Consulting 

and Analytics

Visit www.manpowergroup.com to learn more.
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http://www.manpowergroup.com/
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Do not Include in the Report.
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Color Guidelines

• Do not change graphic or text colors from 

their original state.

– The Global Talent Barometer PowerPoint template uses 

additional colors outside of the document palette to 

enhance the overall design. 

– Backgrounds, charts and text colors have been 

purposefully applied and tested for accessibility.

– Do not use tint shades, standard colors or recent colors 

when localizing the report.
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Saving the Global Talent Barometer Report as a PDF

Exporting your interactive PDF:

– Delete the Appendix (slides 30-36).

– Mac: File > Save a Copy… > File Format > PDF

– PC: File > Save a Copy… > More options > PDF

– Rename and save the document as PDF.

PC

Mac
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